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Le Plan d’action :
•	 Nous allons tout d’abord télécharger le logiciel 

PHPMaker, puis un fichier démo.
•	 Ceci nous permettra d’appréhender toutes les pos-

sibilités de l’outil.
•	 Ensuite, nous ferons un mini-cahier des charges 

pour l’application CRM, en spécifiant le MVC (Mo-
del-Vue-Controleur) :

–	 Model : la structure de BD du CRM (tables, 
champs)

–	 Vue : les écrans que nous souhaitons générer
–	 Controleur : PHPMaker génère le code ! Rien  

à spécifier, hormis du code personnalisé à injec-
ter dans l’outil, ou des modifications du code généré.

Qu’est-ce qu’un générateur de code ?
Les générateurs de code permettent, à partir d’une 
structure de base de données, de créer les écrans clas-
siques de manipulation de données :

•	 listing (d’objets en base de données), moteur de re-
cherche,

•	 page de détail,
•	 formulaires d’ajout/modification et page de sup-

pression.

Ce sont des actions classiques de type “CRUD” (Create-
Read-Update-Delete).

Quand les utiliser ?
Les générateurs sont particulièrement utiles :

Créer un CRM avec  
un générateur de code
Dans cet article, nous allons montrer qu’il est possible  
de créer un CRM complet avec un générateur de code.
Nous utiliserons ici „PHPMaker”, l’un des plus simples  
et efficaces du marché. Il vous permettra de générer des 
écrans CRUD (listings/moteurs de recherches, formulaires 
ajout/modification/suppression) sans taper une ligne 
de code. De plus les écrans générés sont designables, 
multilingues, et sécurisés.

Cet article explique :
•	 Comment créer un CRM (logiciel de gestion de la relation client, 

ou gestion commerciale) avec un générateur de code PHP.
•	 Comment utiliser au mieux le générateur de code PHPMaker.
•	 La gestion de projet spécifique à ce genre d’outils.

Ce qu’il faut savoir :
•	 Aucune connaissance PHP, d’hébergement et administration 

de serveurs n’est nécessaire.

Figure 1. Présentation de l’interface
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Voici l’écran principal de PHPMaker (voir Figure 2).
L’outil ayant pour but de générer des listings et formu-

laires d’ajout/modification/suppression à partir de tables 
et champs, l’interface permet de spécifier pour chaque 
table/champ les paramètres d’affichage et le lien entre 
le champ affiché en HTML et le champ en base de don-
nées.
Il génère donc les pages CRUD : listings/recherche, 

formulaires d’ajout/modification/suppression.
Il permet également de :

•	 générer des tableaux avec pagination, avec export 
Excel/CSV/PDF/XML...

•	 créer des “vues” (comme des vues SQL, avec join-
tures).

•	 créer des écrans “Master/Detail” : par exemple, af-
fichage de la fiche détaillée d’un client, et en des-
sous, affichage du listing des contacts chez ce 
client.

Enfin, il gère le trio sécurité/multilinguisme/design !

•	 sécurité : gestion des utilisateurs, groupes utilisa-
teurs, permissions ou ACL (Access Control List).

•	 multilinguisme : traduction des listings et formu-
laires, messages Javascript de validation de formu-
laire, des éléments de navigation, etc.

•	 design : gestion de thèmes graphiques (“tem-
plates”), gestion de menu de navigation, gestion de 
CSS.

Ceci vous permet de créer une application profession-
nelle, et fournir ce trio sécurité/multilinguisme/design en 
standard, sans taper une ligne de code !

PHPMaker génère des pages HTML/PHP, sur des 
bases de données MySQL, PostgreSQL, Access, SQL 
Serveur, Oracle.
Le code généré n’étant pas crypté, on peut le modifier 

après génération et y apporter tous les améliorations 
souhaitées : éléments de design, insertion d’éléments 
Ajax JQuery, de “widgets” avec de l’information venant 
de services SaaS (Google/Zoho, autre...). Les pages 
générées sont en PHP (d’où le nom “Phpmaker”), il 
suffit ensuite de les copier dans le répertoire ou FTP 
de l’application web (après avoir éventuellement modi-
fié le fichier de configuration contenant les codes login/
password d’accès à la base de données).

Web : http://www.hkvstore.com/phpmaker/.
Démo : http://download.hkvstore.com/phpdemo9/
carslist.php (login/password admin/master).

•	 pour générer des interfaces d’administration avec 
les listings et formulaires classiques d’ajout/modifi-
cation/suppression (gestion de paramètres, gestion 
d’utilisateurs, backoffice de gestion de stock – pro-
duits/catégories/fournisseurs ...)

•	 pour créer des applications avec principalement 
des listings et des formulaires (tel un CRM, un logi-
ciel comptable, une gestion d’association...).

Ils ne sont pas adaptés à la création de logiciels néces-
sitant du code et un affichage particuliers (webmail, ca-
lendrier, explorateur de fichiers, cartographie Google, 
portail de widget de business intelligence...).

Quelques exemples de logiciels :

•	 PHPMaker (200$), PHPRunner (400$), AppGini 
(60$), PHP Generator for MySQL (gratuit, de l’édi-
teur SQL “SQLMaestro”).

Autres logiciels (plus puissants, mais plus complexes), 
donnant des possibilités plus poussées en termes de 
connectivité aux BD, de language de code généré (ASP, 
JSP...) et de personnalisation des écrans générés :

•	 CodeCharge (200 à 500$, application windows, 
génère du code ASP/PHP/JSP, sur de multiples 
bases de données, et intègre un designer visuel 
pour chaque écran, ce que ne fait pas PHPMaker – 
personnalisation uniquement par scripting PHP/JS).

•	 ScriptCase (325$, application WEB, fonctionnant 
dans le navigateur, multi-utilisateur. Génère du 
code PHP, pour des bases MySQL/PostgreSQL/
SQLite/SQL Serveur/Oracle).

Présentation rapide de PHMaker

Figure 2. Ecran principal
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Je vous conseille de jeter un coup d’œil aux différentes 
versions du logiciel (et aux pages “Nouveautés”, “Chan-
geLog”), qui vous permettront d’appréhender plus faci-
lement toutes ses fonctionnalités.

QUICK START. Projet Démo
Avant de créer notre propre application CRM, nous al-
lons télécharger un fichier exemple et générer le code 
correspondant. Tout d’abord, téléchargeons PHPMaker 
à cette adresse : http://www.hkvstore.com/phpmaker/
download.asp. Une fois installé, vous pouvez télécharg-
er un fichier exemple déjà configuré, téléchargeable 
gratuitement sur le site de l’éditeur. URL : http://www.
hkvstore.com/phpmaker/demo.asp, lien “Download the 
Demo Project” ou directement : http://www.hkvstore.
com/phpmaker/php9demo.zip.
Ce projet exemple est une gestion de base de don-

nées de voitures, avec gestion des modèles, fournis-
seurs...
L’utilisateur non connecté peut consulter les listings 

de voitures. L’utilisateur connecté (login/password : ad-
min/master, lien “login”) accède à une interface d’ad-
ministration permettant toutes les opérations CRUD 
(créer/modifier/supprimer) sur les voitures, mais égale-
ment de gérer les comptes utilisateur et les droits d’ac-
cès (permissions/”ACL” Access Control List).

•	 Le fichier contient : le fichier projet “PHPMaker”, et 
le .SQL permettant de créer la base de données.

•	 Créer une base de données locale MySQL “demo” 
et importez-y le fichier .sql avec PHPMyadmin ou 
tout autre éditeur.

•	 Ouvrir le fichier demo9.pmp avec PHPMaker (menu 
“Project” > “Open”).

	 Si vous avez importé le fichier .SQL dans une 
autre base que “demo” avec le login/password 
root/<vide>, faites “Tools > Synchronize”.

•	 Puis allez directement dans l’onglet “Generate”, et 
saisissez dans “Application root folder” le réper-
toire de génération du code PHP, qui doit être dans 
votre serveur web local :

	 C:\xampp\htdocs\phpmaker_demo” par exemple (si 
vous utilisez Xampp).

•	 Si vous avez déjà un serveur web installé, tel 
Apache, cochez “Testing web server : Other”.

•	 Une fenêtre apparaît, cochez “Select All” en haut à 
gauche pour générer tous les fichiers (nécessaire 
la première fois).

La génération de vos fichiers se lance.

Votre application devrait désormais être accessible  
à cette url : http://localhost/phpmaker_demo/carslist.php.

Je vous conseille de cliquer un peu partout dans PHP-
Maker, afin de visualiser tous les paramétrages, et com-
parer avec les pages générées : ceci vous permettra 
de comprendre l’impact de chaque paramétrage dans 
PHPMaker.

Projet CRM
Nous allons désormais nous attaquer à notre projet 
CRM. Le challenge : créer un CRM sans taper une ligne 
de code, en 1 heure maximum.
Un CRM consistant globalement en des listings :

•	 de clients/contacts,
•	 propositions commerciales/bons de commande,
•	 emails/appels téléphoniques/rendez-vous client ef-

fectués, avec les formulaires CRUD (Create-Read-
Update-Delete) d’ajout/modification/suppression de 
données (clients/contacts, ... emails/appels tel/rdv), 
un générateur de code est particulièrement adapté 
à ce genre de projet.

Gestion de Projet
Bonnes pratiques :

Une application réalisée avec un générateur de code 
nécessite la même gestion de projet que tout dévelop-
pement spécifique :

•	 expression du besoin : interviews utilisateurs fi-
naux, et leurs managers – ayant souvent besoin 
d’outils de supervision et de tableaux de bord spé-
cifiques,

•	 benchmark fonctionnel/technique de solutions déjà 
existantes sur le marché : achetons-nous une solu-
tion, ou la développons-nous en interne ?

•	 reformulation du besoin, et comparaison vis-à-
vis des outils existants  vous devez vraiment vous 
mettre en tête que votre CRM interne est destiné  
à être lancé sur le marché.

	 Vous devez le créer comme s’il s’agissait d’un nou-
veau produit que vous vendriez.

•	 détermination des 80% de besoins génériques, 
et des 20% spécifiques (pour lesquels du codage 
spécifique peut être nécessaire).

Chaque société a des besoins spécifiques, mais quand 
on “gratte”, on se rend compte que la plupart des be-
soins sont récurrents, et communs à énormément de 
gens.
Pensez à la loi de Pareto, la règle des 80/20 : les 80% 

de besoins génériques seront rapides à développer, et 
les 20% spécifiques très difficiles.

Et enfin, :
•	 sécurisé, multilingue (d’abord anglais - même s’il 

est destiné uniquement à des français - puis fran-
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çais : français = langue étrangère/secondaire).
•	 documentation complète utilisateur/administrateur/

développeur.
•	 installeur/désinstalleur (création build .exe/.rpm/.

deb).

planification du projet, et découpage en v0, v1, v2, v3 :
•	 v0 : prototype réalisé le plus rapidement possible. 

Faire des “sprint”, à la scrum : livrer très rapide-
ment une nouvelle version testable par les futurs 
utilisateurs (avec un générateur, tous les jours au 
maximum !).

•	 v1 : réalisation des 80% de fonctionnalités géné-
riques demandées (ou réalisables sans problème, 
sans montée en compétence nécessaire sur une 
nouvelle technologie).

•	 v2 : réalisation des “trios” :
–	 sécurité/multilinguisme/expérience utilisateur 

(design/ergonomie/performances),
–	 versionning/tests/documentation (utilisateur/ad-

ministrateur/développeur).
–	 v3 : réalisation des 20% de code spécifique 

(pouvant prendre 80% du temps...).

Qu’est-ce qu’un CRM ?
CRM = “Customer Relationship Manager”.

Gestion de la relation client :

•	 gestion de l’activité commerciale : devis/proposi-
tions commerciales, bons de commande (généra-
tion de factures gérée dans l’outil de compatibilité, 
ne relève plus du commercial).

•	 historique de la “relation” client, par tous les canaux 
de communication habituels email/tel/rdv.

Emails envoyés/reçus, appels sortants/entrants, ren-
dez-vous chez le client ou dans les locaux.

La navigation s’effectue généralement comme suit :
Liste clients
•	 un clic sur client affiche :

–	 la fiche de détail du client (coordonnées),
–	 les propositions commerciales/bons de com-

mandes émis/renvoyés signés par le client,
–	 et la liste des contacts chez ce client.

Enfin, un clic sur un contact affiche la page de détail 
de ce contact et la liste des appels/emails/rendez-vous 
pour ce contact.

Nous pouvons également souhaiter certains listings 
particuliers :
•	 nouveaux clients,
•	 top clients – en termes de CA, clients taggés “VIP” 

– ...

•	 les clients qu’on m’a affectés,
•	 ma TODOlist : liste des appels à passer, des emails 

à envoyer, les prochains réunions...

Et enfin, afficher des tableaux de bord, notamment le 
“pipe” des ventes, affiché habituellement sous forme 
d’entonnoir inversé :

•	 PHPMaker ne pourra pas générer ce genre de gra-
phique, mais il propose l’outil PHP Report Maker 
(http://www.hkvstore.com/phpreportmaker/).

•	 Et vous pouvez utiliser des bibliothèques de re-
porting de type FusionCharts, qui proposent entre 
autres ce fameux entonnoir des ventes inversé : 
http://www.fusioncharts.com/.

Base de données
Voici ici la structure de base de données :

•	 clients :
	 table “customer” : id, name (varchar 255), type (int), 

address_street/address_postal_code/address_city/
address_country (varchar 255).

•	 propositions commerciales :
	 table “opportunities” : id, id_customer (int), name 

(varchar 255), amount (float).
•	 contacts :
	 table “contacts” : id, id_customer (int), firstname/

lastname (varchar 255), email/phone (varchar 255).
•	 rendez-vous :
	 table “meetings” : id, id_contact (int), subject (var-

char 255), date_begin/date_end (datetime), dura-
tion (int).

•	 appels :
	 table “calls” : id, id_contact (int), subject (varchar 

255), date_begin/date_end (datetime), duration 
(int), direction (varchar 255).

•	 emails :
	 table “emails” : id, id_contact (int), subject (varchar 

255), date (datetime), email_from/email_to (varchar 
255), content (text), direction (varchar 255).

Ajoutez pour chaque table, à la fin, les 4 champs des-
cription/comments (text) et date_creation/date_last_
update (datetime).
Vous pouvez copier/coller la requête suivante sur 

chaque table, en changeant uniquement le nom de la 
table :

ALTER TABLE  `calls` ADD  

   `date_creation` DATETIME NULL ,

ADD  `date_last_update` DATETIME NULL ,

ADD  `description` INT NULL ,

ADD  `comments` TEXT NULL
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Vous pouvez également rajouter 2 champs metadata_
categories/metadata_tags (text) pour catégoriser/tag-
ger tous les objets stockés dans votre base de données.
Chaque objet nous entourant peut être catégorisé/

taggé :

•	 type de société = SSII, éditeur de logiciel, entreprise 
finale...

•	 type de contact = prospect, fournisseur, candidat, ...
•	 type de rendez-vous = 1er rdv, qualification besoin, ...
•	 type d’appel ou email = entrant ou sortant...
•	 type d’opportunité = pour un client existant, un nou-

veau client.

RÈGLES DE PARAMETRAGE DES CHAMPS/TABLES :
Tous les champs sont en NULL autorisé, l’id en autoin-
crément, les varchar en taille 255, les dates au format 
datetime. Pour un premier jet/prototype, nous n’effec-
tuons aucune optimisation (cela peut se changer après 
sans problème), l’objectif est de créer la base de don-
nées le plus rapidement possible, afin de générer un 
prototype fonctionnel.
Je préfixe les champs de manière à les regrouper 

ensemble : address_street/address_postal_code/ad-
dress_city/address_country et je mets les champs id_
xxx au tout début de la table, juste après l’ID : ceci per-
met de voir immédiatement les liaisons avec d’autres 
objets/tables.
Quelques bonnes pratiques pour la création de 

champs :

•	 id (et non id_customer, etc...) : toujours id dans 
chaque table (ou id_NomDeLaTable), ensuite dans 
les jointures SQL.

•	 name/title (nom du client, intitulé de la proposition 
commerciale, sujet de l’email...).

•	 description (chaque objet qui nous entoure dans la 
vie de tous les jours possède une description...).

•	 comments (toujours donner la possibilité de com-
menter n’importe quel objet en base de données. 
Cela peut également être utile pour saisir des don-
nées pour lesquelles il manque un champ de for-
mulaire – c’est-à-dire qu’il faut faire évoluer la base 
de données, et regénérer le projet PHPMaker).

•	 date_creation
•	 date_last_update :
	 il est important de savoir qui a fait quoi, et quand 

sur la donnée.

La donnée ne vaut rien si on ne sait pas d’où elle vient, 
et ce qu’elle vaut à un instant T : la tracabilité est très 
importante. Vous pouvez utiliser la méthode QQOQC-
CP : Qui a fait Quoi, Où, Quand, Comment, Combien, 
Pourquoi ? Une application bien conçue doit pouvoir ré-
pondre à ces questions.

Si votre table n’a pas besoin d’être optimisée, vous pou-
vez :

•	 pour les champs texte :
	 utiliser varchar(255) – pour les titres/intitulés – et 

“text” si vous pensez que votre contenu peut dé-
passer les 255 caractères.

•	 NULL autorisé pour chaque champ :
	 C’est au niveau applicatif en PHP et Javascript que 

vous interdirez des entrées vides, pas au niveau de 
la base de données !

PHPMaker gère les champs obligatoires très bien 
(coche “Validation > Required” et case “Error Message” 
pour définir votre message d’erreur Javascript, en mul-
tilingue !).

•	 des noms de champ en anglais :
	 Arrêtez de penser franco/français, et créez d’abord 

votre application pour l’international, et ensuite pour 
la France. (Français = langue secondaire !).

	 Les éditeurs de logiciels fonctionnant bien (type Ta-
lend) se lancent d’abord à l’international, puis re-
viennent en France, qui est un marché beaucoup 
plus petit.

Première génération rapide
Pour générer une application, seuls 2 écrans sont réel-
lement nécessaires :
•	 onglet “Database” pour définir les informations de 

connection.
•	 onglet “Generate” pour générer les fichiers PHP/Ja-

vascript/autres !

Spécifiez ici les informations de connection dans les 
champs Server, UserName, Password, Database : le 
serveur local, le login/password de l’utilisateur de base 
de données, et enfin le nom de la base de données.
Usuellement : localhost, root, “” (mot de passe vide), 

et base “crm” dans le cadre de ce projet.

Figure 3. Connection à la base de données
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Il faut avoir préalablement créé l’utilisateur de BD et 
la base de données (dans PHPMyadmin par exemple, 
souvent livré avec les “stacks” “tout-prêts” de type 
Xampp ou Wamp). Après avoir cliqué sur Connect, vous 
visualisez les tables sur votre gauche (voir Figure 3). 
Allez ensuite directement sur l’onglet Generate (voir Fi-
gure 4).

Dans cet onglet “Generate”, vous générez l’applica-
tion en saisissant dans “Application root folder” le réper-
toire de destination, où sera généré le code PHP. Ce 
répertoire doit être dans votre serveur web local, par 
exemple : “C:\xampp\htdocs\crm”, si vous avez installé 
Xampp (racine du serveur web : “c:\xamp\htdocs”).
 Si vous avez déjà un serveur web démarré (ex. 

Apache), décochez “IIS Express”. Vous pouvez cocher 
“Browse after Generation” si vous souhaitez lancer l’ap-
plication dans votre navigateur à chaque nouvelle gé-
nération/regénération.
Ou vous pouvez aller manuellement dans votre navi-

gateur et tapez l’url correspondante, ici “http://localhost/
crm/”.

Génération en cours  : fichiers communs/includes/as-
sets (js/css/images), puis 5 fichiers par table : xxx_info.
php, xxx_list.php, xxx_add.php, xxx_edit.php, xxx_de-
lete.php où xxx est le nom de la table.

Fin de la génération (voir Figure 9) !

Figure 4. Liste des tables après connection

Figure 5. Onglet Générer

Figure 6. Paramètres de génération

Figure 7. Sélection des pages PHP à générer

Figure 8. Génération en cours
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Vous retrouvez bien ici 6 pages, affichant les 6 listings 
de clients, contacts, proposition commerciale, appels 
téléphoniques, emails, et rendez-vous. PHPMaker a 
donc généré pour chaque “objet” (client, contact...) non 
seulement un listing paginé (20 lignes par page), mais 
également un moteur de recherche, et les formulaires 
de création/modification/suppression.

À ce stade, nous pouvons stocker nos données, mais :
•	 les données ne sont pas reliées entre elles (com-

ment dire que les contacts n° 3 et 4 sont reliés au 
client 1 ?),

•	 et l’interface ne permet pas de naviguer dans la 
donnée : je liste les clients, je clique sur un client 
pour afficher les détails de ce client (coordonnées, 
chiffre d’affaires total, ...) et la liste des propositions 
commerciales pour ce client.

De même, il faut implémenter le schéma de navigation 
“Master-Detail” suivant :

Liste clients => détail client + liste contacts chez ce 
client => détail Contact + liste appels/emails/rdv pour 
ce contact.

Ensuite, nous allons améliorer le trio “sécurité/multilin-
guisme/expérience utilisateur (design/ergonomie/per-
formances) :

•	 traduction de l’application en français.
•	 améliorer l’expérience utilisateur :  “UX” / design et 

ergonomie : amélioration kit graphique, menu de 
navigation, champ HTML pour saisir des commen-
taires, menus.

•	 sécurité : gestion utilisateurs, log de tous les ac-
cès à l’application, historisation des modifications 
des données (qui a modifié quoi, quand et pourquoi 
– idéalement).

Et enfin, faciliter et améliorer la recherche et l’accès  
à l’information :
•	 mise en place d’un moteur de recherche avancé,
•	 exports excel/csv,
•	 quelques vues de type “top 10 clients”, “10 derniers 

clients”, “répartition CA par secteur d’activité”.

Deuxième génération
Nous allons désormais paramétrer en détails PHPMa-
ker afin de faire une seconde génération correspondant 
plus à nos souhaits, précédemment listés. Nous allons 
donc parcourir de manière méthodique tous les écrans 
de paramétrage PHPMaker, comme suit :

•	 le plus important : paramétrages des tables et vues 
(“Custom Views” et “Reports”), puis des champs 
pour chaque table.

•	 le “+” (“trio” sécurité/multilinguisme/design), dans 
les onglets PHP/HTML/Security et le menu “Tools”.

Voici la liste des tables (cliquer sur « Tables » dans le 
menu gauche, voir Figure 12).
 Nous spécifions ici, pour chaque table, si nous géné-

rons une page de listing, un formulaire d’ajout/modifica-
tion/suppression…

Figure 9. Fin de la génération !

Figure 10. Interface web générée

Figure 11. Ormulaire d’ajout

Figure 12. Paramétrages des tables : liens ajout/modifier/supprimer
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En cliquant sur sur le nom d’une table dans le menu 
gauche, nous listons les champs de cette table, et pou-
vons donc, champ par champ, définir :

•	 dans la section « View Tag » : son affichage dans 
les listings (mise en forme/couleur/police, lien href 
sur le champ…).

•	 dans la section « Edit Tag »  : son affichage dans 
les formulaires d’ajout/modification (input/select 
menu/radiobouton…).

Il est conseillé de paramétrer dans l’ordre :

•	 les tables, puis les champs,
•	 le trio multilinguisme/design/sécurité.

Revenons donc au paramétrage des listings. Vous pou-
vez définir ici les options de listing :
•	 la pagination (nombre d’enregistrements à afficher 

par page), affichage de la pagination en haut ou en 
bas (ou les 2)

•	 l’affichage ou non, ou à gauche/droite, des liens 
“détail/copier/modifier/supprimer” pour chaque en-
registrement.

•	 la fonctionnalité d’export, et les formats d’export 
proposés (CSV, Excel, PDF, XML...).

Ensuite, pour chaque table, vous pouvez définir si vous 
souhaitez générer un listing, un formulaire d’ajout/modi-
fication, un mode « grille » (édition à la Excel)…

Pour chaque table, vous indiquez ici les fonctionnalités 
proposées aux utilisateurs :

•	 “inline add/edit”, “grid add/edit” : possibilité d’ajou-
ter/éditer en mode ligne (comme dans Excel) dans 
les listings, au lieu d’être redirigé vers un formulaire 
(vertical) d’ajout/modification de données,

•	 “view” : génération page de détail.

S’il y a une page au moins à générer, c’est celle-ci !, pour 
le mode “lecture seule” aux personnes non-autorisées 
à modifier les données. En effet, les listings ne peuvent 
pas tout afficher, entre autres les champs “text” conte-
nant potentiellement énormément de données, la page 
de détail vient donc en complément du listing pour affi-
cher les données non affichées dans les listings. On sim-
plifiera donc les listings –pas de scrolling horizontal – en 
n’affichant que le strict nécessaire – c’est-à-dire qu’on 
masquera par exemple dans les listings l’userID ayant 
créé l’enregistrement, la date de création mais on affiche 
la date de modification, le champ “commentaire” etc.).

•	 “add/copy” : affichage des liens “ajouter/copier” dans 
les listings (et génération des pages adéquates),

•	 delete/edit : génération des pages supprimer/édi-
ter, et affichage des liens adéquats dans les listings 
(à droite ou à gauche, selon ce que vous avez 
configuré dans PHPMaker - onglet “PHP > List/
View Page Options”),

•	 captcha : affichage d’un “captcha”,
•	 quick/advanced/highlight   : recherche rapide (sur 

tous les champs, à la Google), avancée (recherche 

Figure 13. Paramétrages des champs : type de champ de formulaire 
d’ajout/modifications, affichage dans listing

Figure 14. Options de listing (pagination, liens d’actions, exports CSV...)

Figure 15. Paramétrage des tables (inline edit/add...)

Figure 16. Paramétrage des tables (view, add, delete, update)

Figure 17. Paramétrage des tables (multi-update, search, audit trail)
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multicritères), surlignage des résultats de la re-
cherche,

•	 audit trail : historisation de toutes les modifications 
effectuées sur cette table (ajout/modification/sup-
pression partielle ou complète d’enregistrements).

•	 Email notification on Add/Edit/Delete : à cocher si 
vous souhaitez être averti par mail à chaque créa-
tion/modification/suppression sur certaines tables.

Astuce : vous pouvez également créer un flux RSS sur 
la table “Audit Trail” via le logiciel XMLMaker du même 
éditeur, et enregistrer ce flux RSS dans Outlook/Thun-
derBird ou tout autre lecteur email. À utiliser avec par-
cimonie.

Pour chaque champ affiché sur les pages de listings, 
pages de détail et formulaires d’ajout/modification, vous 
devrez indiquer :

•	 son lien avec la base de données (quel champ de 
BD afficher ou mettre à jour),

•	 sa mise en forme.

La mise en forme vous permet de modifier : gras/italique, 
fontes, couleurs, liens bref sur ce lien... Par exemple, PHP-
Maker affiche sur les listings un lien détail.php?id=[id] sur 
les ID redirigeant sur la page de détail. Vous pouvez déci-
der de rajouter ce même lien de détail sur le titre : sélec-
tionnez alors “id” dans le champ “Href field” et ajoutez le 
préfixe “détail.php?id=” dans le champ “Hyperlink > prefix”.

Lien avec la base de données :
PHPMaker gère tous les types de champ de base de 
données, et tous les types d’affichage :

•	 varchar : affichage d’un champ texte (input) ou mot 
de passe.

•	 text : affichage d’un textarea, ou d’un éditeur HTML 
enrichi (extension CKEditor).

•	 date : affichage champ texte + popup de sélection 
de date (extension JS Calendar).

Vous pouvez également afficher des cases à cocher 
(checkbox), boutons radio ou menus déroulants (pou-

vant être “cascadés” : la sélection d’un menu rafraîchit 
le menu en dessous, utile par exemple pour saisir la 
catégorie/sous-catégorie d’un produit par exemple).
Et enfin, les champs “hidden” (variable cachée) et 

“fichier” (pour uploader des fichiers). Vous devez avoir 
précédemment paramétré le répertoire où seront stoc-
kés vos fichiers uploadés : onglet “PHP > General Op-
tions > File Upload” 2012-07-19_185619 - onglet PHP 
- General Options - File Upload.png.
Pour chaque champ ou presque, vous pouvez définir :

•	 la taille du champ (texte), hauteur/largeur (textarea), 
le nombre maximal de caractères tapés.

•	 le caractère obligatoire du champ (ne doit pas être 
vide, affichage alors d’un message d’erreur Javas-
cript : paramétrable, et en multilingue !).

•	 “use Lookup table”...

Enfin, vous pouvez relier ces champs à des tables, par 
exemple, afficher le nom d’un client lors de la saisie 
d’un nouveau contact.
Ceci est indispensable pour relier un contact à un 

client (c’est-à-dire stocker l’ID du client dans la table 
des contacts), et également pour afficher dans les lis-
tings des contacts le nom du client (PHPMaker n’affi-
chera donc pas l’ID du client pour le contact, mais le 
nom).
Ceci est également utile pour afficher une liste de 

checkbox/radioboutons ou un menu déroulant dont la 
liste des entrées est définie dans une table de paramé-
trage.
 Ainsi, vous pouvez modifier en temps réel le contenu 

des menus déroulants/checkbox/radioboutons, et d’au-
tant plus facilement que vous aurez pris soin de générer 
un listing phpmaker pour cette table de paramétrage.
Pour effectuer ceci, cochez “use Lookup table”, et 

indiquez ensuite dans “table name”, “link field”, “dis-
play field” le nom de la table/le nom mysql du champ. 
Par exemple, pour afficher la liste des clients dans un 
menu déroulant, on sélectionnera la table “account”, 
link field=”id”, display field=”name”. Et on trie en crois-
sant sur le nom du client avec order by=”name”, Asc/
Desc=”Asc”.
Personnellement, je stocke les contenus de tous les 

champs (menus déroulants/checkbox/radioboutons), 
pour toutes les tables, dans une unique table “setup_
fields” (id, table_name, field_name, field_value, field_
label), et ensuite dans le “Use lookup table”, je filtre sur 
le nom de la table, pour n’afficher que les options de ce 
menu déroulant :

“`table_name`”=’nom_de_ma_table’ AND `field_name`”=

   ’nom_de_mon_champ’”.

Figure 18. Options de paramétrage d’un champ
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Le Master Detail permet de créer un lien entre 2 objets 
de bases de données.
Dans le cas d’un CRM :

•	 pour un client donné, nous avons envoyé plusieurs 
propositions commerciales.

•	 pour un client donné, nous avons plusieurs 
contacts chez lui.

•	 pour un contact donné, nous stockons la liste des 
emails envoyés et reçus, les appels entrants et sor-
tants, les rendez-vous chez ce client ou dans nos 
locaux.

Nous avons donc une liaison de type 1-n entre client 
et proposition commerciale, entre client et contact, et 
entre contact et emails/appels/rendez-vous.
PHPMaker par défaut nous affichera 6 listings : la 

liste des clients, la liste des propositions commerciales 
pour tous les clients, la liste des contacts pour tous les 
clients, la liste des emails/appels/rendez-vous pour 
tous les contacts
Et nous souhaitons naviguer de la sorte : liste clients > 

je clique sur un client, ce qui affiche le détail du client et 
la liste des propositions commerciales et contacts pour 
ce client.
Je clique sur un contact, et cela affiche le détail du 

contact et la liste des emails/appels tel/rendez-vous 
pour ce contact.
On appelle ceci le “Master-Detail” : Master=détail de 

la fiche client, Detail = liste des contacts pour ce client.
Pour activer cette navigation, cliquez sur “Tables” 

dans le menu gauche (ne cliquez pas sur le nom d’une 
table), et cliquez ensuite sur le bouton “Modify” en bas 
à droite, dans la section “Master/Detail”.

Les custom scripts servent à personnaliser les actions 
gérées par le code généré :

•	 actions CRUD (Create-Read-Uodate-Delete), c’est-
à-dire créer/modifier/supprimer + les listings et 
pages de détail.

Le code que vous saisissez ici sera inclus dans le code 
généré. Ce système vous évite donc de devoir modi-
fier le code une fois généré. En effet, si vous faites une 
modification dans le logiciel et devez regénérer, vous 
perdez les modifications faites dans le code généré et 
devez les ressaisir ou copier/coller.
Un bon générateur de code vous permet d’inclure du 

code personnalisé *avant* la génération.
Gestion du trio « Sécurité/Multilinguisme/Expérience 

Utilisateur  » (design/ergonomie/Performances). Multi-
linguisme.
Pour activer le multilinguisme, vous devez effectuer 

les 3 opérations suivantes :

•	 dans le menu “Tools > Languages”, cochez les lan-
gues que vous désirez utiliser dans votre application.

Si la langue désirée n’apparaît pas, vous pouvez té-
lécharger le fichier XML correspondant (par exemple 
“french.xml”) sur le forum de l’éditeur.
Enregistrez ensuite les fichiers XML dans le dossier 

“languages” de l’application, par exemple : “C:\Program 
Files\PHPMaker 9\languages”, puis fermez et relancez 
le logiciel.
Si le fichier de langue n’existe pas, vous pouvez créer 

le votre, en vous basant sur un fichier XML existant.

Une fois les langues cochées, vous pouvez activer le 
multilinguisme dans l’onglet “PHP > General Options” :
•	 cocher “Multi-language” pour activer le support 

multilingue,
•	 et indiquez la langue par défaut dans le menu “De-

fault Language”.

Figure 19. Master/détail

Figure 20. Custom Scripts

Figure 21. Multilinguisme : options générales

Figure 22. Multilinguisme : options générales (suite)
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•	 enfin, vous devez saisir les traductions pour 
chaque entrée de menu, libellé de table, champ, 
et autres éléments (footer/header des pages, mes-
sages d’erreur Javascript pour la validation des 
champs...).

Pour cela, allez dans “Tools > Unicode Property Edi-
tor” qui centralise toutes les traductions. Vous pouvez 
également cliquer dans le champ “Caption” (libellé) des 
tables et champs, ce qui fait apparaître une petite icone, 
laquelle affiche la fenêtre de traduction pour ce champ.

N’oubliez pas tous les petits paramètres liés à la langue :
PHP  > General Options :

•	 locale : Set Locale : “fr_FR”,
•	 format d’affichage de la date : Default Date Format : 

“dd/mm/yyyy”

HTML  > General :

•	 Charset : “iso-8859-1 (Western European (ISO))”.

PHPMaker affichera sur chaque page générée un menu 
de langue, en haut à droite, vous permettant de chan-
ger de langue à tout moment.

Figure 23. Multilinguisme : traduction des labels de champs

Figure 24. Multilinguisme : traduction des menus, messages d’erreurs 
Javascript...

Design
Tout se trouve dans l’onglet “HTML” (hormis la gestion 
du menu de navigation).

“HTML > General” :
Vous pouvez ici définir entre autres le titre de votre 
application, le header (logo...) et le footer (texte copy-
right...).

“HTML > Themes” : vous pouvez choisir ici d’utiliser un 
thème graphique prédéfini ou “template”, avec des css 
prédéfinies pour les textes, le fond de pages, les fonds 
des lignes de tableaux... Définissez enfin le header (lo-
go par exemple) et le footer (copyright par ex.).

“HTML > Styles” :
Vous pouvez également créer vos propres CSS avec 
l’éditeur intégré.

Figure 25. Design : titre, header/footer, police...

Figure 26. Design : template graphique
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Ergonomie
Vous pouvez “enrichir” et simplifier l’expérience utilisa-
teur en activant des extensions complémentaires, par 
exemple :

•	 le “CKEditor” (éditeur HTML enrichi, mieux qu’un 
simple champ “textarea”).

•	 et le “JS Calendar” (affichant une “popup” de calen-
drier pour sélectionner le trio jour/mois/année) au 
lieu de le taper.

Les extensions sont activables via le menu “Tools > Ex-
tensions”.

Menu de navigation
PHPMaker affiche un menu gauche sur toutes les 
pages générées ; une entrée de menu est créée par 
défaut pour chaque table ou vue. Vous pouvez décider 
ici d’afficher ou nom l’entrée de menu, en créer de nou-
velles vers d’autres pages non générées via PHPMa-
ker, ou des entrées de menu ne pointant nulle part, et 
servant juste à regrouper des liens.
Si le menu ne vous convient pas, vous pouvez ne pas 
le générer, et insérer dans les pages PHPMaker un me-
nu “hand-made”, créé par vous-même via un autre outil 

Figure 27. Design : éditeur de styles CSS 

Figure 28. RIA : extensions DHTML (éditeur HTML, popup de date) Figure 29. RIA : menu de navigation
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(par exemple Sothink DHTML Menu, ou des menus 
Dans le cadre de notre projet CRM, le menu généré par 
défaut par PHPMaker pourrait être le suivant :

•	 Clients
•	 Contacts
•	 Propositions commerciales
•	 Appels Téléphoniques
•	 Mails
•	 Rendez-vous   

Nous pouvons ajouter des entrées de menus, et rajou-
ter des “vues” (comme des vues SQL), afin d’arriver à 
ce menu :

•	 Mes...
   	 Clients
   	 Propales      
•	 Clients
   	 Clients actifs
  	 Prospects

   	 Anciens clients
•	 Nouveaux clients
   	 Clients VIP
•	 “Pipe” des ventes
   	 Propositions commerciales envoyées (80)
   	 Propositions commerciales acceptées (10)
  	  Bons de commandes envoyés (8)
  	  Bons de commandes validés (5)
•	 Administration
   	 Gestion de la sécurité
     Utilisateurs
     Historique des modifications

Vous pouvez créer des vues SQL dans PHPMaker : cf 
« Custom Views » dans le menu gauche .
   “Mes Clients” et “Mes Propales” seraient des vues :  
la liste des clients ou propositions commerciales, fil-
trées par l’ID de l’utilisateur connecté.
“Clients actifs”, “Prospects”, “anciens clients” seraient 

également des vues : la liste de clients, filtrés par leur 
“status” : actif, inactif,...

Figure 30. Sécurité : protection par mot de passe

Figure 31. Sécurité : gestion d’utilisateurs et groupes

Figure 32. Sécurité : gestion d’utilisateurs et groupes (suite)
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“Nouveaux clients” et “Clients VIP” : liste des clients 
triés par date décroissante (et filtrés par exemple : date 
entrée aujourd’hui et aujourd’hui moins 1 mois), liste 
des clients triés par chiffre d’affaire décroissant.
Pour le “Pipe” des ventes, cela dépend de votre CRM.

Sécurité
Vous pouvez indiquer si vous souhaitez protéger votre 
application simplement par un couple identifiant/mot 
de passe unique saisi ici “en dur” (hardcodé), commun 
pour tous les utilisateurs. Vous pouvez également acti-
ver une gestion des accès via une base d’utilisateurs, 
des groupes utilisateurs, et des “ACL” (Access Control 
List).
Ces “ACL” permettent de manière très fine de spéci-

fier qui a le droit de faire telle opération (consulter/lister, 
créer/modifier/supprimer, copier/exporter...). Untel peut 
seulement consulter la donnée, un autre peut modifier 
uniquement certains champs, et un autre peut tout faire 
(le superadministrateur par exemple).

Sécurité – utilisateurs et groupes
Vous pouvez utiliser une table d’utilisateurs externe 
(mais dans la même base utilisée par PHPMaker dans 
l’application) ; dans ce cas, indiquez ici le nom de la 
table stockant vos utilisateurs, et les champs corres-
pondants au login et au mot de passe que devra utiliser 
PHPMaker.
PHPMaker peut créer une table d’utilisateurs si vous 

n’en avez pas encore. De même, il peut créer des tables 
pour gérer les groupes et les permissions (consulter/
lister, créer/modifier/supprimer, copier/exporter...) par 
groupe utilisateur ou utilisateur nommé.
PHPMaker vous propose également de nombreuses 

autres options : mot de passe stocké en md5, xxx ten-
tatives de connection au maximum, affichage d’un capt-
cha, envoi d’un lien d’activation de compte utilisateur 
après création du compte, page “mot de passe perdu”...
Options accessibles via “Security”   > bouton “Ad-

vanced”  > fenêtre “Advanced Security”  > section “User 
Login Options”.

Sécurité – audit trail
L’ “audit trail” est le fait d’historiser tous les accès 
(connections/déconnections) à votre application, ainsi 
que toutes les opérations effectuées sur les données : 
ajout/modification/suppression d’entrées complètes ou 
de champs.
PHPMaker peut créer pour vous la table historisant 

toutes les modifications effectuées sur la donnée – qui a 
modifié quoi, quand – (nom de la table, nom du champ, 
ancienne valeur, nouvelle valeur, userID ayant effectué 
la modification, date de modification).

Email Settings
Saisissez ici les paramètres de votre serveur de mail 
local. PHPMaker peut envoyer des mails dans de nom-
breuses situations :

•	 lors de l’enregistrement d’un nouvel utilisateur, ou 
pour la fonctionnalité “mot de passe perdu”,

•	 la fonctionnalité “Audit Trail” peut vous envoyer un 
email à chaque création/modification/suppression 
d’enregistrements,

•	 vous pouvez envoyer des fiches de détail d’enregis-
trement.

Trucs et astuces
Vous pouvez également vouloir supprimer les liens “dé-
tail/modifier/supprimer” sur chaque ligne, afin d’alléger 
l’affichage. Soit vous les masquez par défaut et les affi-
chez au passage de la souris (le plus élégant), soit vous 
générez les pages sans ces liens, soit vous générez les 
pages avec et masquez ces liens dans le code généré 
(ou la colonne affichant ces liens).
La première méthode implique de modifier le code gé-

néré en mettent ces liens dans un DIV/SPAN avec une 
visibilité masquée par défaut, et de rajouter un événe-
ment onmouseover sur les lignes. Donc des manipula-
tions de code.
La seconde méthode (générer sans ces liens) né-

cessite une astuce : si vous décochez “Edit ”, alors les 
pages d’édition ne seront pas générées. Il faut d’abord 
faire une génération avec détail/édition/supprimer, puis 
décocher et régénérer uniquement la page de listing, et 
rajouter un lien “detail.php?id=[id]” sur l’ID et le titre, par 
exemple. La page detail.php n’ayant pas été régénérée, 
elle affichera les liens vers les pages de modification/
suppression.
Retrouvez les fichiers PHPMaker, .sql, fichiers PHP 

générés à cette adresse : http://pierrenoel-sirh.com/
phpmag/crm_phpmaker.

Pierre Noël  
Coach Open Source, j’aide les entreprises à profiter des technologies 
Open Source afin de créer ou améliorer leur Système d’Information, 
leurs produits et services.

Figure 33. Sécurité : Audit Trail (historisation des modifications des 
données)


